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Quote of the Month

When men are employed, they are best contented . . . . but
on our idle days they were mutinous and quarrelsome.

Benjamin Franklin [Autobiography, Ch. 10]

Should You Worry About
Image Retention On an
LCD Monitor?

by Linda Gonse, Orange County PCUG, http://www.or—
copug . org, editor (at) orcopug.org. Originally published in
Nibbles ‘n Bits, the newsletter of ORCOPUG.

just bought a brand new HP ZR22w LCD flat screen

monitor. My understanding always has been that
burn-in (also called image retention or image persistence)
does not occur on LCD screens. But, an HP help file that
came with my monitor dispelled that notion.

“Image retention occurs when the monitor is left ON
while displaying the same image for an extended period
of time, leaving a ‘shadow’ of this image on the screen.”

I researched the burn-in problem further and About.com,
http://bit.1y/k05c1D, said “Image retention can

be corrected in most cases and is easily prevented.” That
statement was a relief!

The article went on to list methods that could be used to
prevent image retention/persistence.

1. “Set the screen to turn off after a few minutes of
screen idle time under the Power functions in
Windows. Turning the monitor display off will
prevent an image from being displayed on the
screen for extended periods of time. Of course,
this could be annoying to some people as the
screen may go off more than they wish.”

2. “Use a screen saver that either rotates, has mov-
ing graphic images or is blank. This also prevents
an image for being displayed in screen for too
long.”

3. “Rotate any background images on the desktop.
Background images are one of the most common
causes for image persistence. By switching back-
grounds every day or few days, it should reduce
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About k-Byte

Published monthly, k-Byte is the official newsletter of the Front Range Personal Computer Users Group
(FRPCUG). Our mailing address is PMB 152, 305 W. Magnolia, Fort Collins, Colorado 80521.

Opinions expressed in k-Byte are those of the authors and do not necessarily reflect those of the group or its members.
Publication of information in k-Byte constitutes no guarantee of accuracy. Use of any information found in this publica-
tion is at the sole risk of the user. Neither k-Bytfe, nor its officers, nor its editors or contributors assume any liability for
damages resulting from use of information in this publication.

Submissions

Articles, letters and short items of interest on computer-related topics are welcome and encouraged. All items submitted
for publication are subject to editing. Send your contribution to the editor via e-mail attachment or submit on disk. If
you have questions about a submission, please contact the editor for information.

Copyright and Trademark Information

k-Byte is copyrighted © 2011 by the Front Range Personal Computer Users Group. The k-Byte logo and the Front Range
PC Users Group logo are Trademarked by the Front Range PC Users Group. Unless otherwise noted, other nonprofit
users groups may reprint or quote from any articles appearing in k-Byte without prior permission, provided that: a)
proper author and publication credits are given; b) that a copy of the publication in which the article appears is sent at
no cost to k-Byte at the above mailing address, or emailed to contact(at)frpcug.org; and c) any additional instructions/re-
strictions contained in the article are followed. User groups wishing to exchange newsletters with FRPCUG are invited
to send a copy of their newsletter together with an exchange request.

Disclaimer

IBM PC, OS/2, Compagq, HP, Dell, UNIX, Windows, MAC, Apple Computer and other trademarks occasionally men-
tioned in k-Byte are registered trademarks of International Business Machines, Inc., Hewlett-Packard Corporation,
Microsoft Corporation, Dell Inc., Apple Computer Inc. or their owners respectively. Neither FRPCUG nor its newsletter
k-Byte are connected with any manufacturer or seller. Acceptance by FRPCUG of donated products or services from
suppliers, or inclusion of a supplier in the FRPCUG Partner list does not imply that any continuing financial support is
received from or expected by FRPCUG from such activities. Nor do such activities imply an endorsement of either the
supplier or product or service. Such information is made available to members as a service. Use of any product or sup-
plier found in this publication, or any FRPCUG publication, is at the sole risk of the user.

About FRPCUG

FRPCUG is an independent nonprofit computer society, so incorporated with the State of Colorado and open to anyone
interested in personal computers using any operating system: Windows, Linux or MAC, and digital hardware (such as
music/video players, smart phones, etc.). Its purpose is to provide an educational and scientific forum of mutual benefit
for members of the community regardless of knowledge level. FRPCUG holds a monthly meeting and conducts various
special interest groups (SIGs) and seminars. Members have voting privileges, subscription to the k-Byte newsletter, and
access to SIGs and selected seminars. Annual dues are $25 for individual/family membership ($20 for students) and $50
for corporate/group membership.
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Continued from Page 1
4. “Turn off the monitor when the system is not in use. This will prevent any problems where the screen saver or
power function fails to turn off the screen and result in an image sitting on the screen for long times.”

The bottom line is not to be too worried about image burn-in, but keep it in mind when using your LCD monitor and
you can easily prevent it from happening.

If somehow it does happen, see http://bit.1ly/k05c1D for instructions on how to correct existing image retention
on LCD monitors.

Finally, the HP text helpfully revealed another problem not known to all LCD monitor users, “the fluorescent lights
inside the display have a limited lifetime and will gradually degrade.” This is reason enough not to leave a monitor on

24/7, even with a screensaver enabled. Use the timed Energy/Power setting to automatically turn the monitor off when
your system is idle for a while.

u
A Few Tips for Customizing Word 2007

by Nancy DeMarte, Sarasota PCUG, Inc., http://www.spcug.org, ndemarte (at) Verizon.net. Originally published in the
Sarasota PC Monitor, the newsletter of the Sarasota PCUG, Inc.

hen creating Office 2007 programs, Microsoft added new tools and settings designed to save time and simplify

tasks for users. Some of us find that while we appreciate most of these features, a few are getting in our way.
Fortunately, many of these default settings can be disabled or modified. Here are a few customizations that I have
found to be helpful.

Add commands to the Quick Access toolbar: Let us say that you use a certain command often, like the Spelling & Gram-
mar checker, but keep forgetting where it is located in the Word 2007 ribbon. There is an easy solution. You can copy
any command to the Quick Access toolbar, which is always visible in the top left corner of the Word window above the
Office button. To place a tool button there, first find it on the ribbon, right click it and select Add to Quick Access toolbar. If
you have several commands you want to move there, start by clicking the arrow to the right of the Quick Access tool-
bar. Then click a command you want from the list, which puts a checkmark next to it and adds it to the Quick Access
toolbar. You may have to click More commands to expand the list. In this view, click a command in the left pane, and
then click Add to put it on the Quick Access toolbar, shown in the right pane. Repeat for as many commands as you
want, then click OK. Tip: Be a bit selective or your Quick Access toolbar may get so long it blocks out the title of your
document.

Control the space between lines and paragraphs in your customized Normal template: In August 2010, I wrote a Moni-
tor article about how to customize the Normal Template in Word 2007 on which all new documents are based. Re-
cently, I learned that even making those changes does not rid your documents of the extra space between the lines and
paragraphs. Apparently, even Microsoft acknowledges that the Word 2007 line spacing rules are not easy to change.

Word 2003 and earlier versions used single spacing between lines and after paragraphs, which is what many users
would like to get back. Word 2007’s default setting is 1.15 pts between lines and 1.15 plus a blank line after paragraphs.
A fairly easy way to revert your Word 2007 spacing back to the 2003 version is by changing the Style Set. Open a Word
2007 document. Click the Home tab, and then click Change Styles in the Styles group. Point to Style Set and click Word
2003. To make the new style set become the default in Word 2007, click Change Styles again, and then click Set as Default.
If you prefer not to go through all those steps, Microsoft has created a little fix-it tool which will make these changes
for you. You can download it from the Microsoft website at this address: http://support.microsoft.com/
kb/921174.

Create Custom Page Margins: If the margins in your document are not set the way you want them, you can fairly easily
change the margins to your liking. With your document open, click the Page Layout tab, and then click Margins in the
Page Setup group. The Normal setting for Word 2007 is 1 inch on all sides - top, bottom, left and right. Several other

Continued on Page 4
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Continued from Page 3

choices appear in the drop down gallery. If you like one of these, merely click it and watch your document change to
the new margin settings.

If you do not find what you want in the margins gallery, you can create your own customized margins. Open the Mar-
gins gallery and click Custom Margins, which opens the Page Setup dialog box. On the Margins tab, type your desired
settings in the four boxes, leaving Gutter (the area left for binding or hole-punching) at “0” and “left.” If you want these
new margins in effect for only the current document, click OK. If you want to use them for this and future documents,
click Default, and then OK.

Add the Right Kind of Date to Your Document: Many of us like to put dates in our documents to identify when they
were written. But when we open some documents, we find the current date rather than the date it was composed. Word
allows us to enter two sorts of dates and times: a date which never changes or a date which updates automatically
whenever the document is opened. It helps to know how to enter both types since there are occasions when each is ap-
propriate.

To enter a static date, just type it somewhere in the document or footer. Another way is to click the Insert tab and, in the
Text group, click Date & Time. This opens a dialog box where you can choose from several formats for the date and/or
time. Be sure to uncheck the box next to Update automatically if you want the date to remain static.

To enter a date that updates each time you open the document, click the Date & Time button as explained above. This
time be sure that Update automatically is checked.

A way to add a date with specific properties is to add a date “field.” Click the Insert tab, then Quick Parts, then Field. In
the Field box, select the Date and Time category. Here you will find several specialized fields, such as CreateDate, Print-
Date, and SaveDate. A quick way to insert a field for a date is to use the keystroke shortcut, [Shift]+[Alt]+[D].

Get rid of the Mini Toolbar: Whenever you highlight a word or phrase in Word 2007, a mini toolbar of editing com-
mands appears above and almost covering the highlighted text, which can be annoying. The mini toolbar is a new
feature of Word 2007/2010. Its purpose is to put the most commonly used editing commands close to where you need
them. For some this is a time-saver; for others, it’s a pain. Fortunately, you can turn off if it bothers you. To disable this
feature, click the Office button, then Word Options (bottom right), and then Popular. Remove the checkmark from the box
next to Show mini-bar on selection and click OK.

Do you have problems with Office 2007 that need solving? Let me know, and I'll try to include them in a future article. Send to
ndemarte (at) verizon.net.

!
Mac Tip

by Ernie Cox, Jr., Computer Club of Green Valley, AZ, http://ccgv.apcug.org, ecoxjr (at) cox.net. Originally published in
Green Bytes, the newsletter of the Computer Club of Green Valley, AZ.

1. Determine the Integrity of Your Hardware.
If you suspect you have a hardware problem, not related to your Mac’s hard drive, troubleshoot with these three steps:

Run the Apple Hardware Test to confirm or deny your suspicions. Follow these directions: http://support.apple.
com/kb/ht1509. [MacBook Air instructions: http://support.apple.com/kb/ht2644].

Reset your SMC (System Management Controller) to alleviate common problems with fans, power management, sleep,
or lights with these steps: http://support.apple.com/kb/ht3964.

Resetting your PRAM and NVRAM (http://support.apple.com/kb/HT1379) can alleviate problems with volume, screen

resolution, and startup disk selection.
Continued on Page 12
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Discovering Windows 7*

by Neil Stahfest, Tacoma Area PC User Group, http://www.tapcug.org, NCStahfest (at) msn.com. Originally published in
Data Line, the newsletter of the Tacoma Area PC User Group.

his is for all of you who have a laptop PC with Windows 7. As you move your PC between your home, office, li-

brary or meetings, you may need to change some settings such as screen brightness or connect to various networks.
Windows 7 contains a number of controls in the Windows Control Panel that let you make these changes. You can make
these changes individually or at one central location called the Windows Mobility Center. You don’t even need to go to
the Control Panel to reach the Mobility Center. Simply press the Windows Icon key and the letter X on your keyboard at
the same time.

When you do, the Windows Mobility Center will appear, looking ES windows Mabilty Cente
something like the image at right . Different tiles may be displayed Kl oo o= | @) Core T o ' i |
depending upon the version of Windows 7 loaded on your computer
or your computer’s hardware configuration. In addition, some PC 3 3 P2 | TR
manufacturer may customize the Mobility Center by adding some ad- et o e et
ditional controls. A o O e

l Convectdeslsy | Srceetions |
As you can see, commonly used settings such as display brightness, Fe—— e
sound volume and network settings are easily adjustable from here. )

Some settings may not be available because the required hardware is

not connected. In that case the tiles will be greyed out. In the example above, no external display is connected. Wireless
settings may be temporarily unavailable if the hardware switch is turned off. (You may need to check the information
that came with your computer to learn where to find this hardware switch).

On another topic, are you “bugged” by those little windows that occasionally pop up in the corner of your display
screen warning you about Windows maintenance and security items? Usually this happens when you turn your com-
puter on but it can happen at any time. Personally, I want to see messages telling me that there are Windows updates
available for my computer but I don’t care to see messages relating to things like spyware protection and user account
control.

These messages are controlled by something called the “Windows 7

P+ Contsol Faral + Syt endSacuty ¢ Actan Camiar

Action Center.” As usual, Windows gives us several ways to reach p— . = = -

the “Action Center” but I prefer to do it this way. Click on the Win- siplenltai it

dows “Start” button, in the search box enter “action center” and then || &5™=== 3

press “Enter”. You should see something like this: (el R 2
Sctuphadap

Ew 4 e ot o ke 08
T ¥ rasiage st Wincowt Backsg

Now click on “Change Action CenterSettings” (circled in red). A new
window will open that looks something like this: S

[] Trevtibasig fH Focowoy
Fincland I preblame Farsons pour camputer iz an
e

@'@i ¥ Sintomand ouky b Achice Carhr 8 Chirga Acian Cava etteg
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iz doan At bk s prztreya

Wirddot Fragun
Corpubisity |
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As you can see, you can turn off a lot of security and maintenance
Em— messages here. Just uncheck the ones you don’t want to see and click
on the “OK” button. If you change your mind, just click on the check
boxes to restore the messages.

[*Editor’s Note: This article is one of a series on this topic by this author]
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Calendar of Events

Future General Forum Meeting Notes

September General Forum Meeting
We will meet at the Fort Collins Senior Center on:

Day Date Time
Tuesday September 6th 7:00 PM
Meeting Agenda

Time Topic
Announcements and

7:00 to 7:15 Raffles

7:15 to 7:45 Open Forum

7:45 to 7:55 Break

755 to 9:00 Passwords - Proxies - Pro-
tection

To check on FRPCUG events in 2011 using a familiar
graphical calendar format, connect to the

2011 Graphical Events Calendar

October General Forum Meeting
We will meet at the Fort Collins Senior Center on:

Day Date Time
Tuesday October 4th 7:00 PM
Meeting Agenda

Time Topic
Announcements and
7:00 to 7:15 Raffles
7:15 to 7:45 Open Forum
7:45 to 7:55 Break
7:55 to0 9:00 Tablets—What, Why, How?

The September program offers tips on:

e Passwords: what makes a good password, gener-
ating good passwords

* Proxies: use a proxy to keep threats at bay

® Protection: learn about all of the ways your com-
puter is vulnerable

The October meeting topic is: Tablets —What, Why, How?

The iPad has made quite an impact on the computing
landscape over the past two years, and competitors are
doing their best to gain market share in this new plat-
form. What makes tablets different from Tablet PCs? Are
they just a fad, or truly the beginning of a “Post PC era”?

Continued on Page 12

Future SIG’s, Seminars and Other
Meetings

See you at the meetings!

Get full membership benefits. If you are not a current member,
download and complete aMembership Application.
Mail the completed application and your payment to the
address listed, or better yet, bring the application to the
next meeting.

Page 6
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Digital Imaging SIG

The Digital Imaging SIG is a forum for discussion of
digital imaging hardware and software. The meetings are
held every 2nd Tuesday of the month at 7:00 PM in the
Senior Center Lobby. The meeting format is informal, us-
ing the Shop Talk sessions as a basis. For more informa-
tion, contact Mike Morris at twriterext(at)gmail.com.

Shop Talk

One-on-one assistance. Drop in to the Senior Center
lobby on any Saturday (holidays excepted) from 11:00
AM to 1:00 PM.

Technology SIG

The Technology SIG provides advanced support for all
PC related operating system and telecommunication
issues. The meetings are held at 7:00 PM on the third
Thursday of each month at Bluebird Manufacturing Inc.,
1421 Webster Avenue, in Fort Collins. For more informa-
tion, contact Chuck McJilton at 970-493-2987.

Board Meeting
FRPCUG's executive board meets on Wednesday of the
week following the General Forum meeting. All members

are welcome and are encouraged to attend.

These meetings are held at 7:00 PM in the Staff Board Room
of the Fort Collins Senior Center.

September 2011
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The Two Month Activities Calendar

Sunday Monday Tuesday Wednesday Thursday Friday Saturday
1 2 3
Shop Talk 11:00
AM to 1:00 PM
4 5 6 7 8 9 10
General Forum Shop Talk 11:00
Labor Day Holiday | Meeting AM to 1:00 PM
7:00 PM
11 12 13 147 15 16 17
Digital Imaging FRPCUG Board Technology SIG Shop Talk 11:00
SIG Meeting Meeting Meeting AM to 1:00 PM
7:00 PM 7:00 PM 7:00 PM
18 19 20 21 22 23 24
Shop Talk 11:00
AM to 1:00 PM
25 26 27 28 29 30
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
1
Shop Talk 11:00
AM to 1:00 PM
2 3 4 5 6 7 8
General Forum Shop Talk 11:00
Meeting AM to 1:00 PM
7:00 PM
9 10 11 12 13 14 15
Digital Imaging FRPCUG Board Shop Talk 11:00
SIG Meeting Meeting AM to 1:00 PM
7:00 PM 7:00 PM
16 17 18 19 20 21 22
Technology SIG Shop Talk 11:00
Meeting AM to 1:00 PM
7:00 PM
23 24 25 26 27 28 29
Shop Talk 11:00
AM to 1:00 PM
30 31
September 2011 k-Byte Page 7




Tip of the Month

by Sharon Parg Associates, http://www.sharonparqg.com/ and http://www.tips.net/

Understanding Manual Calculation in Excel

When you change a value in any cell of a worksheet, Excel automatically recalculates all the other formulas within the
worksheet. This means that Excel is always up to date, based on any changes you may have performed.

If you have an absolutely huge worksheet or a terribly slow computer (or both), then doing a calculation after every
change can get very tedious. In these situations, you can actually spend more time waiting on Excel to finish calculating
than you do on entering information.

The answer to this problem is to configure Excel so that all calculations are done manually. This is easy to do by follow-
ing these steps:

1. Display the Excel Options dialog box. (In Excel 2007 click the  [caomm ==
Office button and then click Excel Options. In Excel 2010 dis- | [ reau ) Chinge ations e 1o formuls cation. pefemarce,and e
play the File tab of the ribbon and then click Options.) [m—

Peocling Caloulation opfion:
Save Wankzaok Cuulation 7] Erasle pavatios eabiulatian

2. Click the Formulas area at the left of the dialog box. fr— B i i it ervmpab

p— " i change  oas

3. In the Calculation Options section of the dialog box, make - " ’

sure the Manual radio button is selected. e ST

4. Click on OK.

Esiod Chediing
7| tnabie packground emer chetking
Now, Excel does not calculate your worksheet automatically. Instead, e i o [Ga 7] Pt
you must press F9 whenever you want to update the results displayed o g
. . ¥ Ces combsning foemalas that resut [ Femelas which a eels in s regien
within your worksheet. e [EIE I —————
4 r;'i:j'l”zt’:".:l"'““w"" YL Femmilaes refeiing to empty cels
| CEls combrning gears reresented a5 [ s ermered in a tabie i inga i
Repeating Rows for a Table Footer in Word ) o omatisdactat e

reepetied by B0 ApatGELE
| Foreulzs igransstem with ather
Tomvdas inthe mgien

When working with longer tables in a document, you may wonder
if there were a way to repeat rows at the bottom of a table that spans
multiple pages, the same way you can repeat rows at the top of a multi-page table. The short answer is that Word
doesn’t provide such a capability. If you are willing to experiment a bit, you can try to come up with a workaround that
may do the trick for you.

Co)

What you want to do is create a document section that contains just your table, and then use the page footers to contain
the rows you want repeated from the table. Follow these general steps:

Just before the start of your table, insert a continuous section break.

Do the same thing just after the end of your table.

Select the rows you want repeated at the bottom of the table and copy them to the Clipboard.

Choose View | Header and Footer to display the headers and footers of the document. (If you are using Word
2007 or Word 2010 display the Insert tab of the ribbon, click Footer in the Header & Footer group, and then click
Edit Footer.)

Switch to the footer. (You don’t need to do this in Word 2007 and Word 2010, since you are already editing the
footer after step 4.)

Make sure that the Link to Previous option is turned off for the footer.

Select anything that already exists in the footer.

Press CTRL+V to paste the copied rows into the footer.

Use the controls on the Header and Footer toolbar or, in Word 2007 and Word 2010, the Design tab of the rib-
bon to advance to the next section. (You should be looking at the footer for the section following the section in
which the table resides.)

10. Turn off the Link to Previous option for this footer.

Ll A e

o

0PN

Continued on Page 10
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Photo Gallery

This month’s featured photographer:
Bert Broekstra using a Nikon D7000camera

Illinois River, Arapaho Wildlife Refuge, North Park, CO

This photo is a panorama contructed from 4 individual photos using Hugin (http://hugin.sourceforge.net/).

Copyright © 2011 by Bert Broekstra. All rights reserved. Send requests for copies/reprint permissions to kbyte(at)
frpcug.org.
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Ask Computer Tutor

QUESTION: When typing the temperature I would like to insert a “degree” symbol automati-
cally instead of writing the word “degrees.” Is there a shortcut for this symbol?

ANSWER: Yes, there are two shortcuts for the degree symbol.

1. Hold down the ALT key and type 0176 on the numeric keyboard. The degree symbol
will appear immediately. You must use the numeric keypad to type the numbers and
not the keyboard. Make sure that the NUM LOCK key is on if your keyboard requires
it to type numbers on the numeric keypad.

2. AutoCorrect has a predefined keyboard shortcut for creating a degree symbol. Press
CTRL+@, then press SPACEBAR.

QUESTION: Why does my date never go to the correct format when I download my bank ac-
count from the internet even after I go to format-cells date and choose a style?

ANSWER: It will not change unless you change the setting in Global.

If using EXCEL 2007 you will need to change it through the “format-cells” menu but you will also need to change the
location i.e. United States English. Then it will become the format that you have chosen.

QUESTION: While working on EXCEL and have multiple workbooks open at one time, I would like to close them all at
once without exiting EXCEL. Is there a simple way to do this?

ANSWER: You can quickly close all of them, without exiting Excel. Hold down the Shift key as you click on the FILE
menu. When you do this, the Close command, which closes a single workbook, instead becomes Close All, which closes
all your open workbooks.

QUESTION: Is there a way to make a Web Page or pictures on a Web Page larger or smaller, when I visit a website?

ANSWER: Yes, there is a very easy trick to make Web Pages or pictures larger or smaller on a website. Hold down the
CTRL key on your keyboard and scroll the wheel on your mouse.

Pamela invites you to e-mail computer-based questions to: http://tinyurl.com/ask-pamela-computer-tutor. More
often than not you will receive and answer within 24 hours.

Continued from Page 8
11. Delete the table row from this section’s footer.
12. Close the Header and Footer toolbar (click Close) or, in Word 2007 and Word 2010, click Close Header and
Footer in the Close group.

You are now ready to place the final touches on your workaround. Position the insertion point somewhere in your table,
then use the various tabs in the Page Setup dialog box to adjust the relationship between your table and the footer.
You'll need to play with the settings on both the Margins and Layout tabs to position the rows in the page footer, and
you'll want to make sure that the Apply To drop-down list applies the changes to only the current section (the one with
the table in it).

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found

onlineat http://excel.tips.net. Thousands of free Microsoft Word tips can be found online at http://word.tips.
net.
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FRPCUG Contacts
Telephone Area Code 970

Title Name Work Phone Home Phone E-Mail

FRPCUG Officers

President Mike Morris 461-2002 twriterext(at)gmail.com

Vice President Mike Loughlin 416-5824 mlough(at)frii.com
Treasurer Chris Ingham 226-9055 chris.ingham(at)hotmail.com
Secretary Chuck McJilton 493-2987 cdmcjs(at)gmail.com

k-Byte Staff

Editor-in-Chief Mike Morris 461-2002 twriterext(at)gmail.com
Features Editor Mike Morris

Other Contacts

Membership

Coordinator Jack Linder 663-2151 jack(at)frpcug.org

Technology
SIG Leader

Digital Imaging
SIG Leader
Publicity Mike Morris

FRPCUG Fax Line 493-1408

FRPCUG Home Page
w/ E-Mail

FRPCUG Officer E-
Mail

Library Request E- library(at)frpcug.org
Mail

Chuck McJilton 491-1011 493-2987 cdmgjs(at)gmail.com

Mike Morris

http://www.frpcug.org

board(at)frpcug.org

Front Range PC Users Group Is Online at

http://www.frpcug.org
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Continued from Page 6

How do tablets fit into our computing lives? We'll discuss these questions and many more, in addition to demonstra-
tions and hands-on opportunities for this new class of devices.

Continued from Page 4

2. Repair Your Hard Drive.

If your computer is running slowly, files are disappearing, or you get a question mark at startup [this is usually not a
good thing], the problem may be your hard drive. Try these two things before buying a new one:

Use Apple’s free tools to repair your drive. Boot in Safe Mode, run Disk Utility from your Mac OS X Install disc, or run
fsck. These functions are described in detail at http://support.apple.com/kb/TS1417.

Use Disk Warrior ($100, http://www.alsoft.com) to rebuild the drive’s directory, which can repair corruption and
prolong the life of your drive.

3. Reinstall Snow Leopard

When all else fails, try reinstalling Mac OS X 10.6 from the original installation DVD, performing what was formerly
known as an “Archive and Install” of your operating system. This doesn’t take too much time and can often solve big
problems that aren’t hardware related. Afterward, be sure to update your software by choosing Apple Menu > Software
Updates.

Directions and Map to the Fort Collins

. Senlor anter . o - % $
The Fort Collins Senior Center is located at 1200 Raintree Moore Park -4
Drive. This site is situated at the northwest corner of the %'
Shields and Raintree Drive intersection. It is on the north @
side of the Raintree Shopping Center, and just west of the g}
bank building at the corner of Shields and Raintree (see . Evensiar Ci

map at right).

Check the marquee at the main entrance for directions to @l t

the specific meeting room
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